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Crestron RoomView™ 

 

About Crestron RoomView 
Crestron RoomView™ provides a central monitoring station for 250+ control 
systems on a single Ethernet network (more are possible, the number depends on 
the combination of IP ID and IP address). This centralization of information is 
convenient in corporate or educational applications, where each room has 
dedicated hardware and an associated Ethernet-enabled control system. A 
system may control hardware for more than one room. 

• Crestron RoomView monitors each room, including online status, 
system power, lamp life and hardware faults, plus any custom 
attribute as defined by the Administrator. 

• RoomView notifies the operator when an error or help request is 
received. The operator can respond directly to a help request by 
sending a text message to the control system. 

• The Administrator can run diagnostics with Crestron Viewport.  

• The Administrator schedules events to be sent to a room. 

• The Administrator adds, deletes, or edits room information, contact 
information and events, which are logged automatically by the 
software for all users.  

• The Administrator can select specific rooms to be viewable by the 
user. 

• The Administrator can configure Crestron RoomView to 
automatically send e-mail notification to room contacts. 

• The functions and columns of the RoomView screen are 
customizable.  The RoomView display can be configured to 
monitor any available function and/or signal from the SIMPL 
Windows program running on the Crestron processor. Choose any 
function in the system for monitoring and scheduling via 
RoomView and organize these functions into separate Excel-style 
“Tab” views by group, room, function-type, etc. 
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RoomView is available in two versions, free and licensed. For additional 
licensing information, refer to the “License” section on page 3. 

• The free version of RoomView supports 25 rooms, two users (one of 
which is the Administrator), and two contacts. 

• The licensed version of RoomView supports 250+ rooms, multiple 
users and multiple contacts. 

Crestron RoomView Setup 

System Requirements 

Minimum Required PC Configuration 
• Windows 98/NT/2000/XP: 333 MHz Pentium II with 256MB RAM 

• 800 x 600 screen resolution 

• 256 color setting 

Recommended PC Configuration 
• Windows 98/NT/2000/XP: 1.3 GHz Pentium 4 w/512MB RAM 

• 1024 x 768 screen resolution 

• 16-bit (high color) color setting. 

Minimum System Configuration 
Crestron RoomView requires the following minimum system configuration: 

• One PC with Ethernet card and RoomView installed. 

• One or more 2-Series control systems (to a maximum of 250) with 
static or dynamic IP addresses and C2ENET cards installed. The 
C2ENET card provides a gateway that translates UDP into Crestron's 
proprietary CIP protocol. Crestron does not recommend using the PC-
based CNX gateway since most corporate or educational environments 
use dynamic IP addressing. 

• A program for each control system that controls one or more rooms to 
be monitored. The program must contain one RoomView Interface 
symbol in each control system program.  

• (optional) One or more room touchpanels. 

NOTE: X-Generation CUZ limitations may cause some features not to work. 

NOTE: RoomView works on port 41794. 

Other Required Software 
RoomView requires a SIMPL Windows program containing a RoomView 
symbol that communicates to RoomView.  A library update for SIMPL 
Windows may be required in order to edit a program with this symbol.  Library 
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update version 202 or later is required for programs using the RoomView 
symbol.  If you cannot open the demo program provided with the installation 
(RoomView/demo/RoomView.smw) with your current version of SIMPL 
Windows, visit our website at www.crestron.com to download the required 
library update or contact customer service for assistance. 

License Installation 
NOTE: On Windows 98, the RoomView License Manager is installed as a 
standard application and must be started by selecting the icon in the RoomView 
program group in the Start menu. On Windows NT, 2000, and XP, the 
RoomView License Manager is installed as a service and automatically starts 
when the computer is restarted after installation is complete.  On any platform 
the option to run as a service can be changed once the license manager is 
running.   

Use the following procedure to obtain and install the license. 

1. Ensure that the RoomView License Manager is running.  

NOTE: If the icon is not on the task bar, start the RoomView License Manager 
from the RoomView program group. 

2. Right click the RoomView License Manager icon  on the task bar 
and select License.  

 

3. To obtain the license upgrade from Crestron® for 250+ rooms, and 
unlimited users and contacts, contact Crestron at 888- CRESTRON and 
provide the site code displayed on the “Crestron Licensing” window. 

4. Copy the Site Key information as supplied by Crestron in the Site Key 
field and click OK. 
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5. Right-click on the RoomView License Manager icon and select About 
License Manager to view license information. 

 

Shared License Setup (Client/Server) 
RoomView can share a single license among multiple, separate computer 
installations.   

One installation (the RoomView server) installs the license from Crestron and 
the other installations (clients) acquire the license from the computer where the 
license is installed.   

The RoomView License Manager is installed every time the RoomView 
software is installed. When License Manager is running on a networked 
computer, the license is available for sharing with other computers. 

NOTE:  License Manager must be running on the computer where the license is 
installed to share the license with other networked computers. 

Setting up the Server 
This procedure requires setting up the license and setting up the database file for 
sharing. 
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1. Install RoomView. 

2. Acquire and install the license. 

3. Right-click the RoomView License Manager icon in the task bar and 
select Preferences. 

 

4. Check Run as a service if desired.  

NOTE: WIN 98 machines install License Manager with this option unchecked.  

5. Enter the port number for client connections. The default port number 
is 1000, allowable port numbers are 0 to 65535. The port number and 
IP address of the server must be specified in the login window of client 
installations that are connecting to the server.  

6. Use Windows Explorer to browse to the RoomView database folder. 

7. Right-click and enable sharing for the folder. 

Setting up the Clients 
1. Install RoomView on each client machine. 

2. Start RoomView, click Browse, and navigate to the shared database 
folder on the server machine. 

3. Click the License button on the “RoomView Login” window. 

4. Click Obtain remote license. 

5. Enter the IP address or hostname of the server computer where the 
RoomView license is installed. 

6. Enter the port number specified in the Server's RoomView License 
Manager.  
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7. Click OK. 

8. After login, select About RoomView from the Help menu to display 
license information. 
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Adding and Editing Users 
1. Click Users on the Edit menu, or press <Ctrl+U>, or click the Edit 

Users icon , then click New User. 

 

 
2. Enter the username. 
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3. Enter the E-mail address. 

4. Enter and confirm the password. 

5. Select User or Administrator for the program access. 

6. Click the Rooms tab and select the rooms to which this user will have 
access. The Administrator may restrict rooms visible to each user by 
unchecking the check box for a room. By default, all rooms are visible 
to all users: 

 
7. Click OK to save your user. 
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Adding and Editing Rooms  
A room is a location, such as a meeting room or classroom that is controlled by 
one control system. 

In both corporate and educational settings, it is common for rooms to have a 
projector or other "display" device with a light bulb or lamp. Here RoomView 
can monitor both the lamp life and power status of the display device and send 
notification when the bulb requires replacement. 

NOTE: If you are using an unlicensed version of RoomView, you are limited to 
a maximum of 25 rooms. 

Other parameters that RoomView can monitor are the online status of the 
control system, power status, error conditions, help requests and custom 
attributes as defined by the Administrator. You can also schedule system events 
to occur at regular times. Refer to “Scheduling Events” on page 20 and “Adding 
and Editing Contacts” on page 17 for additional information. 

Adding a Room  
1. Click Rooms on the Edit menu, or press <Ctrl+R>, or click the Edit 

Rooms icon . Then click New Room to create a new room or select 
an existing room and click Edit. 
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2. Enter a name for the room, and then enter the room location and group 
if desired. In large applications, the location and group can help 
organize the rooms and provide useful search parameters.  

NOTE: You can assign a new group or select from an existing group by 
clicking the drop down arrow. 

 
3. Enter the IP address or host name (DHCP) of the control system, and 

then select the IP ID. This is the IP ID assigned to the interface in the 
control system's SIMPL Windows program. If a hostname is used 
instead of an IP address, click the DHCP enabled box. 
 
Each combination of IP addresses and IP IDs must be unique. That is, 
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two rooms can have the same IP address so long as the IP IDs are 
different. Similarly, two rooms can have the same IP ID so long as the 
IP addresses are different. Of utmost importance is that the IP ID that 
you select for a room matches the IP ID of that interface symbol. 

NOTE: Changing the IP ID requires recompiling the SIMPL Windows 
program. 

4. The e-Control Link box specifies an internet URL or IP address to 
which the Internet Explorer can browse when the e-Control Link option 
is selected in the context menu.  If no e-Control Link address is 
specified, the option is hidden in the context menu.  An e-Control Link 
allows the RoomView user to browse to web pages for a given room. 
An e-Control Link can also point to an executable file generated by 
VisionTools Pro-e.  The browse button is used to select the web page or 
.exe file that should be launched when the "e-Control" context menu 
item is selected for a room. 

5. If an external gateway is used instead of the control processor acting as 
its own gateway, select the External gateway option and enter the IP 
address of the gateway. 

6. When you are satisfied with the room settings, click Save Room and 
then click Close. Alternatively, you can delete the room by clicking 
Delete Room. You can also delete all the rooms in the database by 
clicking Delete All. 

NOTE: Save Room replaces all previous information with the new information. 
Save As retains the old room information and adds a new room with the new 
information. 

NOTE: After saving the room, three additional tabs appear: Attributes, Contacts 
and Events. Each room can be assigned it's own combination of attributes, 
contacts and events.  

Editing Room Parameters 
1. Disconnect the room before making any changes. 

2. Edit the room information fields. 

3. Click Save Room. This saves the original room with your changes. 

Creating a New Room that has Similar 
Parameters to an Existing Room 

1. Disconnect the similar room before making any changes. 

2. Edit name, location, IP ID and IP Address, and any other room 
parameters. 

3. Click Save As. This saves your changes as a new room and makes no 
change in the room you used as a model. 
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Adding and Editing Room Attributes 
Attributes define a monitored signal for a room, such as room lights, system 
power, etc. An attribute can be a digital, analog, or serial signal and is assigned a 
join number. The join number must have a corresponding signal mapped to the 
RoomView symbol in the SIMPL Windows program. Custom attributes require 
changes to the RoomView symbol and to the SIMPL Windows program to 
function. An attribute must be assigned to a room in order for that room to 
monitor the attribute signal. RoomView supplies ten attributes that are applied to 
all rooms by default. You can keep or disable any of these, and you can add 
attributes of you own making.  

The standard list of reserved attributes appear in the following order: 

Name, Location, Group, Online, Log, System Power, Display Power, 
Display Usage, Help, and Schedule. 

These reserved attributes cannot be deleted, but they can be individually 
disabled and renamed. Attributes can be selected to appear for particular rooms, 
and not for others.  

Use the following procedure to add a new room attribute. 

1. Select Attributes from the Edit menu, or press <Ctrl+A>, or click the 
Edit Attribute icon . 
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2. Reserved attributes are displayed in gray and cannot be deleted.  Click 

New Attribute to create a new attribute or select an existing attribute 
and click Edit.  

NOTE: The signal type and join number of reserved attributes are fixed and 
cannot be changed. 

NOTE: If the option to apply to all rooms is selected, the room tab is not shown. 
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3. In the General Tab, enter a Signal name. This is the title of the new 
attribute. 

4. Select a Signal type from the pull down list (Digital, Analog, or 
Serial). The signal type determines which graphics are available to 
display the attribute. 

5. Enter a Group name or select one from the pull down list. 

6. Assign a Join number.  The join number must match the corresponding 
signal in the SIMPL program.  Refer to “Control System 
Configuration” on page 47. 

7. Select the Graphic icons for this attribute. Digital attributes have icons 
for off and on states.  Analog attributes have a single graphic to display 
the current value of the signal.  Serial attributes display the signal text. 
Digital room attribute icons can be changed to an icon selected from a 
pull down list on the “Edit Attributes” window. 

8. If this attribute pertains to all rooms, select the option Apply attribute to 
all rooms. 

9. If the attribute should be displayed on the main screen and/or on the 
main screen context menu, select the options Display on main view or 
Show on context menu. 

10. Click the Alert tab. 

 
11. Check the Send e-mail alert for this attribute option to enable e-mail 

alert notification for this attribute or uncheck the option to disable alert 
notification for this attribute. Refer to “Adding and Editing Contacts” 
on page 17. 

12. Select the condition for which an e-mail alert is sent: 

• For digital signals, choose notification when the signal is on, off or 
both. 
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• For analog signals, choose equal to, equal or less than, equal or 
greater than or not equal to the specified alert notification value. 
This window allows you to define the condition under which an e-
mail is sent to the assigned room contact.  

 
• For serial signals, you can specify a specific string of characters. 

11. The alert can be customized on a per room basis. Click the Attributes 
tab in the “Edit Room” window, and highlight the Alert Value field to 
enter a custom notification value for the alert. 

 

NOTE: Contacts must be assigned to the room in order to receive e-mail alerts. 
Refer to “Adding and Editing Contacts” on page 17. 

12. If the option Apply attribute to all rooms is not checked, click the 
Rooms tab. 
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13. Check all rooms to which the attribute applies.  

14. Click OK to save your changes. 
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Adding and Editing Contacts 
A contact is the e-mail recipient that receives notifications based on the 
attributes assigned to a room. These can include (but are not limited to) errors, 
help information, and low display lamp life notifications for one or more rooms.  

1. Click Contacts on the Edit menu, or press <Ctrl+T>, or click the Edit 
Contacts icon . 

 

 
2. Click New Contact to create a new contact or select an existing contact 

and click Edit. 

3. In the Name & Address tab enter the contact's name and address.  
The contact's full name is the only required field.  
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4. Click the Phone & E-mail tab and enter the telephone numbers and e-

mail addresses.  

5. As shown below, you can enter up to four e-mail addresses for event 
notification. 
 

 
6. Click the Rooms tab and select the rooms that pertain to this contact.  
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NOTE: A room may have more than one contact and a contact may be assigned 
more than one room. 

 
When you are satisfied with the settings, click OK. 
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Adding and Editing Events 
Events are signals automatically sent from RoomView to the room at a 
scheduled date and time.  Similar to attributes, events contain a name, type 
(digital, analog, or serial), and a join number that must be programmed in the 
SIMPL program.  An event can have a start and end date or be indefinitely 
repeating, and can be sent on any combination of days. 

1. To create or edit events, select Events from the Edit menu or press 
<Ctrl+E>, or click the Edit Event icon .  

 
 

 
2. The scheduled time for an event can be changed by clicking the time 

field and entering a new time for the selected event. Click New Event 
to create a new event or select an existing event and click Edit.   

NOTE:  Reserved events are displayed in gray and cannot be deleted. 
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3. In this digital example of a new event (Room Lights On), the join 

number is 50, and the data state is 1 (signal on). 

NOTE:  Digital events are a pulsed signal (similar to a button push). The 
control processor receives a high then a low for this digital join. 

4. In an analog event, the data value can be any number from 0 to 65535. 

 
5. In a serial event, the data string can be any string of up to 255 

characters.  
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Setting an Event Value 

 

Use the following procedure to set the schedule for this event. 

1. Click the Enable this event box to turn the event on and off. 

2. Click the Repeating event box if you want the event to repeat 
continuously.  Uncheck this option to specify a start and end date in the 
Start date and End date fields. 

3. Set the default time for the event. The default time will be used for all 
rooms to which the event is assigned. The time may be customized for 
any room by changing the event time from the Events tab in the “Edit 
Room” properties window. 
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NOTE: After a default time is modified, changes to the default time in the “Edit 
Events” window will not affect the customized time. 

4. Click the Weekdays box to select Monday through Friday or click any 
combination of weekdays for the event. 

5. Click the Weekends box to select Saturday and Sunday or click any 
combination of weekend days for the event. 

6. Click the Rooms tab. 
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7. Check all rooms that should send this event, or click Select All to 

enable this event for all rooms. 

8. Click OK to complete the entry of a new event. 

9. Remember that any new event must be included in the SIMPL 
Windows program to operate.  You can edit the room or event 
information by selecting Rooms on the Edit menu. Alternatively, you 
can right-click the room and select Edit or Schedule from the 
submenu. 

NOTE: Refer to “Using Crestron RoomView” on page 30 for additional 
information. 
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Groups 
The room and attribute groups are used to associate rooms with similar 
characteristics.  

The group is assigned when you create or edit a room, or an attribute. Rooms 
can be arranged by group on the main screen. 

You can create any name for a group, and then display the particular group of 
rooms that share the same room group or attribute group.  

1. Select Groups from the Edit menu, or press <Ctrl+G>, or click the 
Edit Group icon . 

 

 
2. The “Edit Groups” window allows you to select either room groups or 

Attribute groups to view on the main screen. Check the box or boxes of 
the group(s) you want to display. 
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3. You can choose to view the rooms by Room Group or Attribute Group. 
When viewing by group, tabs are displayed at the bottom of the screen 
for each of the selected groups. Click a tab to display the room(s) 
belonging to that group.  
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Preferences 
Click Preferences on the Edit menu to set system preferences (Administrator 
only). 

 

General Tab - Startup Options 
• Select the Connect rooms when database opens check box to 

automatically connect the rooms when the database opens. (Otherwise, 
you need to right-click each room on the main screen and select 
Connect, or select Connect All Rooms from the File menu.) 

• Select the Automatically reconnect rooms if disconnected check box to 
automatically reconnect rooms that have been disconnected when the 
database opens. 

Program Options 
• Select the Disable all scheduled events check box to disable all 

scheduled events 

• Select the Disable audible alert for incoming error messages check box 
to disable the alarm sound for incoming error alerts. 

• Select the Disable audible alert for incoming help requests check box 
to disable the alarm sound for incoming help requests. 

• Select the Disable auto-scrolling checkbox to prevent the main screen 
from automatically scrolling an updated room into view when its 
attributes change.  

• Select Disable highlight when updating checkbox to prevent the 
highlight border on the main screen from switching between rooms as 
they are updated.   

• RoomView allows multiple users to access the same database 
simultaneously. Select Check for database updates to automatically 
detect changes in the database made by other users.  You can set 1 
through 10 minutes, hours, days or weeks. Refer to Simultaneous 
Database Access for more information.  

Because this version of RoomView allows multiple users to access the same 
database simultaneously, you can also automatically Check for database 
updates. You can set 1 through 10, and choose minutes, hours, days or weeks. 
Refer to “Simultaneous Database Access” on page 29 for more information. 
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E-mail Tab 
The E-mail tab allows you to specify the network's e-mail server, which is used 
for e-mail notifications. You can also suspend e-mail notification or log e-mail 
delivery errors. The port can also be defined, the default value is 25. 

In cases where authentication is required for a particular mail server, You may 
set this up on the Use Authentication feature on the E-mail tab. 

 

Room Messages Tab 
If the RoomView database is open, you will also see the Room Messages tab 
shown below. Here you can pre-define up to five responses to help requests. 
This makes it convenient to respond quickly to the most common help requests, 
without having to type a custom response each time. 
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NOTE: If you have a licensed version of RoomView, you may also create 
custom messages. 

 

Simultaneous Database Access 
Multiple users can be viewing the same room database at the same time. 

While the database is open, it may be modified and updated by an 
Administrator. 

If the option to automatically Check for database updates is enabled, and a 
change in the database is detected, the following dialog is displayed to all active 
RoomView sessions viewing that database. 

 
If you choose Yes to reload the database, then all current room connections are 
terminated while the database reloads.  
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Using Crestron RoomView 

First Time Login 
Initially, RoomView opens with the following screen: 

  

No password is initially required. 

NOTE: The Administrator should change this password as soon as possible to 
avoid unauthorized access. 

NOTE: Passwords are save encrypted in the database. 

1. Browse to a desired database if you have one from a previous version. 

2. Click OK. 

3. Click the Connect all rooms checkbox to open the rooms at startup. 

NOTE: You may elect to connect all rooms from the login screen.  

Refer to “Shared License Setup” on page 4 for additional information. 
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Administrator and User Privileges 
RoomView is a password-protected program with two levels of permissions, one 
for Administrators and the other for Users.  

• Administrators can add or edit rooms, contacts and users, connect to 
control systems and run diagnostics.  

• Users can connect to control systems, respond to incoming help 
requests and monitor room status.  

• The Administrator can edit, add or delete users at any time.  

NOTE: If you are using an unlicensed version of RoomView, you are limited to 
two users, one of which must have Administrator access. 

Whenever you start RoomView you will be prompted for a user name and 
password. The first time you start RoomView you can enter "Admin" as the user 
name and leave the password field blank. You should then set a secure 
Administrator password for subsequent RoomView sessions. 

 

Administrator Setup 
1. Click Users on the Edit menu, or press <Ctrl+U>, then click Edit. 

 
2. To set an Administrator password, select Admin as the user name, or 

enter a new user name for the Administrator. 

3. Enter the e-mail address. 

4. Enter and confirm a password. 

5. Select Administrator for the program access. 
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6. When you are satisfied with the Administrator settings, click OK. The 

next time you start RoomView you will need the new user name and 
password to log on as Administrator. 
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Establishing a Connection 
When RoomView opens, a grid of rooms and attributes are displayed. If no 
connection is established with a control system, all the status fields display  

 as shown below. 

 
To establish an individual room connection, right-click a room and select 
Connect from the submenu.  

 
To connect all rooms, select Connect All Rooms from the File menu.  

 
Alternatively, you can set system preferences to establish connections 
automatically at startup. To do this, click Preferences on the Edit menu, go to 
the General tab and select the Connect rooms when database opens check box. 
There is also a check box on the Login window for the same purpose.  
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Navigation 

Tool Bars 
Administrator Tool Bar 

  

Log Off - Used to change the active user or database. You must log off to 
switch to a different database. The new database is specified on the Log-in 
screen. 

Find Room - Used to locate a specific room in a large installation. 

View Log - Displays a log of activity for the room selected. 

Edit Attributes - Opens the “Edit Attributes” window. 

Edit Rooms - Opens the “Edit Rooms” window. 

Edit Contacts - Opens the “Edit Contacts” window. 

Edit Events - Opens the “Edit Events” window. 

Edit Users - Opens the “Edit Users” window. 

Edit Groups - Opens the “Edit Groups” window.  

About - Displays the version number and date, number of room licensed, and 
number of rooms used. 

User Tool Bar 
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Main Window 

 
The main window provides the following ten default columns of attributes for 
each room.  

Attribute Definition 
Name Name assigned to a room by the Administrator 

Location Location assigned to a room by the 
Administrator 

Group Group name assigned by the Administrator 

Online Online/Offline room status 

Log Automatic room log entries 

System Power System Power status (On, Off or Error) 

Display Power Display Power status (On, Off or Error 

Display Usage Lamp life of the display (If applicable) 

Help Help notification for a room 

Schedule Scheduled events for a room 
 

• Default attributes may be renamed 

• The join number of default attributes may not be changed 

• The icon for digital attributes may be changed 

• The icon for analog attributes may not be changed  

• Additional attributes may be added (Refer to “Room Attributes” on 
page 12) 

NOTE:  Column width is adjustable using a mouse to pull or push the dividing 
line between the column headings. Dragging the column heading can also 
reorder columns. 
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The sort arrow in the header shows which attribute the rooms are currently being 
sorted by and the sort order (ascending or descending).  The sort attribute can be 
selected by clicking the desired attribute header item.  The sort order can be 
toggled between ascending and descending order by clicking the current sort 
attribute header item. 

Show/Hide Columns 
Columns can be hidden by right clicking on the column header and selecting 
Hide. 

To reveal a hidden column, right click on any column header and select Show. 

Main Window Icons 

 

NOTE: A choice of additional icons is available; refer to the “Edit Room 
Attributes” feature on page 12. 

Detail View 
The Detail View shows all the attributes pertaining to the selected room, even 
when the attributes are hidden on the main screen. This feature provides a way 
to monitor the status of a particular room or rooms while the other rooms are 
updated in the background. You may open as many detail views as desired. 
Room attributes are sorted in the same order as they appear on the Main 
Window. 

1. Left click on the name field of any room to display its Detail View. 

2. Click the Digital, Analog and Serial buttons to view any and all 
combinations of signal types.  
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Menu Selections 
RoomView offers five pull down menus: File, Edit, View, Window and Help. 

The File menu allows you to connect and disconnect all rooms, Log off to 
change databases or users, and exit the program. 

 
The Edit menu permits editing of attributes, rooms, contacts, events, groups and 
users. It also provides the Find Room utility and access to the preferences 
selections. 

 
The View menu allows you to turn the Toolbar, Status Bar and Grid displays on 
or off. The Default Layout selection returns the screen to the default settings. 
Access is provided in this menu to view the Entire Log File for the RoomView 
system. 
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The Windows menu permits you to minimize, restore, close or cascade all open 
detail view windows. 

 
The Help menu provides access to the Help Topics, Live Update, and the About 
RoomView screen. 
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Monitoring Rooms  
When you start RoomView and open the database, the screen displays a grid 
with attributes and status indicators for each room.  

The Name, Location, and Group fields are set by the Administrator when adding 
rooms. In large applications with many rooms, you can use these fields as search 
parameters—Refer to “Find Room” on page 44. 

The Online field indicates the online status of the control system. 

The Log field shows control system notices, warnings and errors, all of which 
are automatically sent via e-mail to the designated room contact. The control 
system program determines which errors are reported to RoomView; thus 
RoomView may not indicate every error that can occur. When an error is 
received, the monitoring operator can retrieve the application log file by clicking 
the error icon. The following log views are available: 

• Left click in the Log field of a room to observe the log file for that 
room only. 

• Right click on a room and select Control Processor Log to observe the 
system log file. 

NOTE: Not available on X-Generation control systems. 

Click the View Log icon or choose View | Entire Log File from the menu 
to observe the entire RoomView Log file for all rooms. 
  

For troubleshooting communications, network or system problems, the 
Administrator can select Diagnostics from the submenu to start Crestron 
Viewport. 

NOTE: A change in the status of any monitored action in a room causes that 
room to be highlighted, bringing the room to the attention of the operator. 

The System Power field monitors the status of the control system. As with other 
indicators, the exact meaning of this field depends on the control system 
program. 

The Display Power and Display Usage fields monitor the power status and lamp 
life of a display device such as a projector (as set by the Administrator when 
adding the room). The display use indicates when the bulb or lamp needs to be 
replaced and is shown as a bar graph.  

The tick marks are: 

 green through 50% usage 

 yellow at the 51-80% mark  

 red when usage reaches the 81-100% mark 

The Help field indicates when a help request is received (described more in 
detail later in this section). 
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The Schedule field shows whether a room has scheduled events. 

• The icons that have been selected for custom attributes reflect current 
status. 

• If the rooms are sorted by a particular attribute, and the status of the 
room attribute changes, the order of the display changes accordingly. 

• Only the Administrator can set system preferences to establish all 
control system connections automatically. To do this, click 
Preferences on the Edit menu, go to the General tab and select the 
Connect Rooms When Database Opens check box. 

• Alternatively, you can open connections by right-clicking each room 
and selecting Connect from the submenu, or select Connect All 
Rooms from the File menu. 

 
Once a system is online, the status of the room is displayed through the various 
indicators, as shown in the following table. Additional icons are available (refer 
to “Room Attributes” on page12). 
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Sending Messages 
NOTE: Send Message is only available with the licensed version of the 
software. 

The Administrator or User can send messages to a room. 

1. Left-click in the Help column or right-click the room and select Send 
Room Message from the menu. 

 
2. Select the room if this was not the one you intended or if you want to 

send messages to different rooms. 

3. Select the message from the pull down menu or type a new message 
name. 

4. Type the message and click Send or Send All to send the message to 
all rooms.  

 
Refer to “Help Requests” on page  for additional information. 
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Help Requests 
A control system program can send help requests to RoomView. That is, a user 
in a room can flip to a help page on the room's touchpanel and press a help 
message button to send a help request to the monitoring station. When 
RoomView receives the help request, the Help status indicator for that room will 
change to a red plus sign. You can select one of the pre-defined response 
messages set in system Preferences, or type a custom response with a maximum 
of 254 characters. 

NOTE: The custom response feature is only available with the licensed version 
of RoomView. 

 

To view the help request and send a response, click the plus sign . This 
displays information about the current room and the current help message 
received. (You can also select previous messages that have not been deleted.)  
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• Click Send to send the text message to the control system. The 

message is displayed on the error page of the room's touchpanel. 

• You can view messages from other rooms by selecting the room from 
the drop-down list. You can remove messages by clicking the Delete 
buttons. Click Close to return to the main screen.  

• The plus symbol remains until all help requests have been responded to 
or deleted.  
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Find Room 
RoomView provides a search feature that makes it easy to locate a room in large 
applications with many rooms. You can search by name, location, group or IP 
address. 

1. Click the Find Room  button (or click Find Room on the Edit 
menu, or press <Ctrl+F>, and select the search parameters from the 
Name, Location, and Group lists. 

2. When you click Find Next, RoomView starts the search and selects the 
first matching room.  
The room is highlighted by a blue border.  

3. To work with the room, click the Edit Room or Delete Room buttons.  

4. To skip to the next matching room, click Find Next.  

5. When you are finished searching, click Close. 
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Log File 
RoomView automatically records all database and control system activity into a 
text file as it occurs. The file is called RoomView.log and is located in the 
RoomView | Log folder. 

When the error icon  is displayed for a room, click the icon. The log file 
contents for only that room are displayed. If you select Delete Log from the file 
menu while viewing the contents for an individual room, only the log contents 
for that room are deleted from the log file. 

To view the entire log file for all rooms, click the View Log  icon (or click 
Entire Log File on the View menu). Each information item is stamped with the 
date and time.  

 
To search for a particular item click Find on the Log File Edit menu. Then 
enter the search parameter. 

1. Click |<First to go to the first page 

2. Click Last>| to go to the last page 

3. Click <<Back to go back five pages 

4. Click Forward>> to go forward five pages 

5. Click <Previous to go back one page 

6. Click Next> to go to the next page 

When you click Find Next, RoomView highlights the first matching entry it 
finds. To skip to the next matching entry, click Find Next. 

You can clear all logging data by clicking Delete Log on the Log File's File 
menu.  

You can also refresh the data by clicking the Refresh Log button. 

You can export the contents of the log file to an Excel spreadsheet by clicking 
Export. 
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You can use Windows Explorer to open RoomView.log in Notepad.  

Control system programming can monitor the status of devices connected to the 
system and can bring up an icon based on the equipment malfunction. 
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Crestron Programming 

Control System Configuration 
Each control system that is monitored by RoomView must have an Ethernet card 
and IP address. 

In addition, the SIMPL Windows program must include an RoomView Interface 
to allow communication with RoomView. The RoomView installation package 
includes a sample SIMPL Windows program called RoomView.smw, located in 
the \Demo folder. The sample program shows how the Interface symbol detail 
should be defined (this is explained later in this section). 

NOTE: The join numbers (with the exception of the analog, digital and serial 
joins for new room attributes) in the Interface are fixed and must be the same for 
every control system program. 

If you do not use the sample program you can bring the Interface into an 
existing program by dragging it to Detail View from the Ethernet Modules 
(Generic) folder of the Device Library. 

 
Both the IP address of the control system and the IP ID of the RoomView 
Interface symbol must match the room settings you specify in RoomView. To 
set the IP ID of the RoomView Interface, double-click the symbol in System 
Views and click the IP Net Address tab. Select the IP ID from the drop-down 
list, and set the IP address to localhost: 127.0.0.1—the loopback address of the 
control system.   
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This creates an entry in the "default" IP table that you can send to the control 
system when you upload the program. Alternatively, you can manually enter the 
above values into the IP Table using the Viewport Setup IP Table command. 
You can then send the IP Table to the control system without need to re-compile 
and resend the entire SIMPL Windows program. 

After you set the IP information, go to Program View and open the symbol 
detail. The RoomView Interface must be defined as shown below. That is, the 
join numbers are fixed and must be the same for every control system program. 
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Digital Signals 

• <SysPwrOn> and <SysPwrOff>  are routed from RoomView to the 
control system. These signals correspond to the "System On" and 
"System Off" events that can be scheduled in RoomView. For example, 
if the Administrator schedules a "System On" event for a particular 
time, the <SysPwrOn> input will go high at the scheduled time. You 
can define the System On and System Off events in whichever way 
your application requires. You could, for example, connect these 
digitals to logic in the program that turns the room's audio on or off. 

• About 15 minutes before the System Off event is initiated, 
<SysOffWarning> goes high. This is the default setting and can be 
changed by editing the scheduled time for the SysOffWarning event. 
 In this way, RoomView notifies the room that the System Off event is 
about to initiate, giving the user time to cancel the event if necessary. 
Cancelling an event from a room can be accomplished by programming 
a join to send a message to the operator from the room touchpanel. 

• <SysPwrOn-FB> is routed to the RoomView "System On" field. 
When high, this signal indicates that the System On event is active; 
when low, no System On event is currently active. 

• <DispPwrOn> and <DispPowerOff> are routed from RoomView to 
the control system. These signals correspond to the "Display On" and 
"Display Off" events that can be scheduled in RoomView. For 
example, if the Administrator schedules a "Display On " event for a 
particular time, the <DispPwrOn> input will go high at the scheduled 
time. A "display" device refers to a projector or other device with a 
light bulb or lamp. You can define the Display On and Display Off 
events in whichever way your application requires. You could, for 
example, connect these digitals to logic in the program that turns the 
room's projector on or off. 

• About 15 minutes before the Display Off event is initiated, 
<DispOffWarning> goes high. This is the default setting and can be 
changed by editing the scheduled time for the DispOffWarning event. 
 In this way, RoomView notifies the room that the Display Off event is 
about to initiate, giving the user time to cancel the event if necessary.  

• <DispPwrOn-FB> is routed to the RoomView "Display On" field. 
When high, this signal indicates that the Display On event is active; 
when low, no Display On event is currently active. 

• <dig-o50> and <dig-i50> are expandable (50 to 100) digital joins for 
adding new room attributes. 

Analog Signals 

• <PingPong> signal is automatically sent by RoomView to the control 
system at regular intervals in order to monitor the connection status of 
the control system.  If a network error occurs sending the PingPong (or 
any other signal), the room disconnects and switches to "offline" status. 
If the option to automatically reconnect rooms is on (refer to 
Preferences), the signal continues to be sent. When it is successfully 
received by the control system, the room "online" status is restored. 
This signal does not need to be connected and may be left blank. 
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• <DispUsage> is routed to the RoomView "Display Use" field, and 
indicates the light bulb usage in a display device such as a projector. 
The expected lamp life (in hours) is set by the Administrator when 
adding a room. In the example program, a SIMPL+ module called 
COUNTLAMPHOURS.usp counts elapsed lamp hours whenever the 
display is on. Alternately, many projectors keep track of lamp hours. 
This value must be obtained and sent back. 

• <an-o50> and <an-i50> are expandable (50 to 100) analog joins for 
adding new room attributes. 

Serial Signals 
• <HelpResponse> sends a pre-defined help request to RoomView, 

usually as the result of a button press on a room touchpanel.  
 
When RoomView receives a help request, the "Help" status indicator 
becomes a red plus sign. The operator can then view the help request 
and send either a pre-defined or custom response back to the 
touchpanel via <HelpMsg>.  

• <ser-o50> and <ser-i50> are expandable (50 to 100) serial joins for 
adding new room attributes. 

NOTE:  HelpResponse has been re-named to HelpRequest in later versions of 
RoomView.  
 
NOTE: Both the help request and response can consist of a maximum of 255 
characters. 

• <ErrorMsg> sends a formatted error string to RoomView and invokes 
an icon change in the error column depending on the severity of the 
error.  When the icon is clicked, the log file opens and displays all 
logged events for the clicked room.  For RoomView to interpret the 
error string correctly, the string must be formatted as "<error 
severity>:<msg>", where error severity is the severity code 0-4, and 
msg is the message string.    

 
Severity Code Definitions  

0 = OK 
1 = Notice 
2 = Warning 
3 = Error 
4 = Fatal Error  

A SIMPL+ module called RoomViewMsg.usp has been provided in the 
\Demo folder that formats a string as described above before it is sent 
to RoomView.  The SIMPL Windows program must send the severity 
as an analog value and the message as a serial string as input to the 
module.  The program then needs to pulse the digital input send signal 
of the module, causing the module to format the string.  If the error 
string is not formatted correctly, RoomView assigns a default severity 
to the error and logs the entire string. 

• <Log Text> Records serial string data into the RoomView log file. 
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Network Traffic Analysis 
Crestron’s RoomView software reports facility wide audio, video, and room 
status via an Ethernet infrastructure and TCP/IP communications.  The presence 
of these TCP/IP packets will introduce a negligible load on the network of a 
typical facility when RoomView is running.  Even large-scale integrations with 
many control systems will not add a significant network traffic load since 
packets are sent periodically, not continually.   

The following scenario demonstrates an approximate network load introduced 
by RoomView communicating to one control processor over a period of one 
hour.  Each packet is approximately 12 bytes unless otherwise noted. 

Room Connection Request – Upon start-up of RoomView software, a 
connection request is generated from RoomView to the room control system 
totaling 24 bytes.    

Room Update Upon Initial Connection - After connection, a single packet is 
sent from RoomView to query the current status of all room variables.  The 
result is a maximum of five return packets, totaling 72 bytes.  From this point 
forward, any data transmission to update these variables is event driven from the 
control system.  Therefore it is sent in real time when the event occurs, resulting 
in a 12-265 byte message for each event.  A typical event would be represented 
by a function such as the user in the room pressing the “Help” button on a touch 
panel. 

Room Connection Monitoring - While a room is connected, RoomView sends 
a single packet “ping” signal to the control system every five seconds.  This 
packet does not generate a response unless the TCP/IP message is rejected.  
Therefore the traffic generated with this function is 144 bytes per minute, or 
8640 bytes/Hour for each room control system defined in RoomView. 

Display Status Reporting – In order to keep the Display Status bargraph in 
synch with its respective room display device, a single packet is sent from the 
control processor to RoomView for the display usage once an hour totaling 12 
bytes/Hour. 

Results - The sum of all these events is 8748 bytes over one hour.  This 
calculation is for the automatic events controlled by the software, and does not 
include events invoked by an operator in a room, or the operator of RoomView.  
The largest possible packet would be invoked by a help request containing a 
serial string of 255 characters, resulting in a packet that would total 
approximately 265 bytes.   
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Crestron Viewport 
To troubleshoot communications, network or system problems, the 
Administrator right clicks the room and selects Diagnostics from the submenu 
to start Crestron Viewport. 

 

NOTE: Viewport works on port 41795. 

The Crestron Viewport is a broad-based mechanism that performs multiple 
system tasks. It is used for diagnostics and to observe system processes, upload 
new operating systems and firmware, change network settings, and 
communicate with network device consoles, among many other tasks. Viewport 
can also function as a terminal emulator for generic file transfer. All of these 
functions are accessed through the commands and options in the Viewport 
menus: 

 

Viewport: File Menu 

Save Current Buffer 
Saves incoming data to an ASCII text file (the Viewport buffer holds about 10 
kilobytes of data). Browse to the desired target directory, enter a filename (it 
will have a .cap extension) and click Save.  

Log Incoming Data to File 
Writes incoming data to an ASCII .log file. To begin logging click Start, 
browse to the desired target directory, enter a filename and click Save. As data 
comes into the Viewport console it will be written to the file, together with a 
Time Stamp that gives the date and time (to the nearest second) that the data was 
received. 

To halt the logging operation, click Stop or Pause. 

Exit 
Closes Viewport. 
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Viewport: Edit Menu 

Copy 
Copies the selected text to the Clipboard. 

Paste 
Writes the contents of the Clipboard to the Viewport screen and transmits the 
pasted characters using the selected connection (as if they were typed in). 

Clear Data 
Clears the Viewport buffer and all displayed text. 

Viewport: Setup Menu 
Use the Setup menu to set preferences for the display of characters in the 
Viewport Incoming and Outgoing data panes, and to specify communications 
and port settings.  

Auto Baud Search 
Cycles through all baud rates (if the control system is not detected) until 
communication is established.  

If communication still cannot be established, an error message will be displayed. 

Local Echo 
Displays any command issued to the COM port. 

Display in Hex Mode 
Displays all incoming and outgoing data in hexadecimal notation. Otherwise, 
data is displayed in ASCII format. 

CR to CR/LF (Outgoing) 
Converts any carriage return (CR) character that is issued to the COM port into a 
carriage return/line feed (CR/LF). 

Sound 
Interprets any incoming character that represents a sound (for example, the 
<Bel> character) as a Viewport-specific command, and emits the sound. 

Destructive Backspace (Incoming) 
Interprets any incoming backspace character as a Viewport-specific backspace 
command, thus removing the previous character from the Incoming data buffer. 

Show Program Load Output in Incoming Data Window 
Program load output is data that is generated at the completion of a Send 
Program command. In 2-Series control systems, enabling the Show Program 
Load Output option is identical to clicking Program Reset after a program is 
transferred to the control system. 
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In X-Generation control systems, this option will display the same information 
as with a Hard Reset, in addition to any errors generated during program 
transfer. (These errors will not be displayed using the Hard Reset command.) 

Character Mapping 
Character mapping is used to control how incoming and outgoing data is 
displayed (when the Display in Hex Mode option is not enabled). The 
“Character Mapping” window is divided into three areas, according to the range 
of ASCII character values (Refer to “ASCII Conversions” on page 74): 

1. Low Characters controls the display of characters with ASCII values 
below 20 hex. These characters represent commands, such as <Esc> or 
<Line Feed>. 

• The Normal option will display the ASCII equivalent of the 
character. 

• The Translated option will display the character represented by 
control and function keys. For example, <Ctrl+@>, which 
corresponds to the NULL character, would be displayed as 
<NUL>.) 

• The Hex option displays the character in hexadecimal notation. 

• The Always Interpret CR, LF, and TAB option interprets carriage 
returns, line feeds, and tabs as Viewport-specific commands, and 
the characters themselves will not be displayed.  

2. Standard Characters pertains to characters with values between 20 hex 
and 7E hex. These can be displayed either in ASCII (click the Normal 
check box) or hexadecimal notation. 

3. High Characters pertains to characters with values above 7E hex. 
These can be displayed either in ASCII (click the Normal check box) or 
hexadecimal notation. 

Each range of characters can be displayed or hidden by selecting or clearing the 
corresponding Show check box. 

Font 
Sets the font, style and point size for Viewport characters. A preview of the 
resulting text is displayed in the Sample area. 

Split Window (Alt+W) 
Viewport data can be displayed in a split window arranged vertically or 
horizontally, with Incoming data displayed in one pane and Outgoing data 
displayed in the other. 
  
1. Point to Split Window, then click Horizontal or Vertical. To display all 

data in one window, click Off. Alternatively, press <Alt+W> to cycle 
through each mode. 
  

2. To resize the split window panes, position the cursor along a border or 
corner, and drag to the desired size. 
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Setup Sequence Keys 
Viewport provides up to 10 sequence keys, which are key combinations 
(<Ctrl+F1> through <Ctrl+F10>) that automatically transmit serial strings 
when pressed.  

From the “Sequence Setup” window, type the string in the text field 
corresponding to a <Ctrl+F> key combination. Once the sequence keys are 
configured, the string will be transmitted whenever Viewport is open and the 
key combination is pressed. 

Communications Settings (Alt+D) 
Viewport functions and diagnostics require an RS-232 or TCP/IP connection 
between the control system and the PC. After making the physical cable 
connections use Communications Settings to specify the connection type. 
Simply click RS-232 or TCP/IP. The available parameters differ depending on 
the connection type. 

RS-232 Connection 
 
For RS-232, the default PC settings match the serial protocol that the control 
system expects. 

The default PC settings are as follows: 
• Port = COM 1. Select the correct COM port on the PC (COM 1 

through COM 8). 
• Baud rate:  

115200 for 2-Series  
• Parity = None. 
• Number of data bits = 8. 
• Number of stop bits = 1. 
• Hardware handshaking (RTS/CTS) enabled. 
• Software handshaking (XON/XOFF) not enabled. 

TCP/IP Connection 
For TCP/IP, enter the IP address of the control system in the Fixed text field to 
connect to the control system automatically whenever Viewport is launched. 
Alternatively, choose Prompt on Connect to specify the IP address each time a 
new connection is established. 

Other Settings 
The Mode for Network Transfer option pertains to the method for uploading 
firmware to network devices. In most cases firmware is uploaded via XModem, 
but some devices, such as the CNTV, require ASCII uploads. In these cases the 
Line Pacing for ASCII Uploads field sets the number of milliseconds the 
Viewport will wait between sending lines of data during the upload. 

Modem Settings 
Specifies the initialization string that is sent to the PC or control system modem, 
to configure and prepare it for use. (The actual dial-up connection is made using 
the commands on the Viewport Remote menu.) Viewport provides default 
initialization strings that are standard for most modems; to recall these, click 
Restore Defaults. 
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Enter a time in seconds for the connection to be attempted before hanging up. 
Click the Drop DTR check box to close the connection by turning off the Data 
Terminal Ready signal. Finally, click Turn Modem Speaker Off to disable the 
sound of the modem connection. 

Communications Presets 
Communications presets are shortcut keys or key combinations that can be used 
to specify communications settings automatically. That is, once a preset is 
configured, pressing the key combination will set the associated 
communications parameters (for either RS-232 or TCP/IP). 

1. Point to Communications Presets and then click Add. 

2. Type a name for the preset, and then select the desired key combination 
from the Hotkey drop-down list. 

3. Click the Communication Settings button and set the desired 
parameters. Click OK. 

4. Click OK again to exit or to assign another preset. 

After a preset is configured it can be deleted or changed by pointing to 
Communications Presets and selecting Remove or Modify. 

Restore Defaults 
The Restore Defaults command restores the following default settings: 

• Viewport screen set to default size and position. 

• Split Window mode is turned off. 

• Font = Terminal (9 pt). 

• Local Echo is enabled. 

• Display in Hex Mode is disabled. 

• Show Program Load Output is disabled. 

• Character Mappings are set to defaults. 

• CR to CR/LF is enabled. 

• Sound is enabled. 

• Destructive Backspace is enabled. 

• Auto Baud Search is enabled. 

Viewport: Diagnostics Menu 
Use the Diagnostics menu to get information about the control system and 
network devices, and to determine whether communication exists between the 
control system and the PC. 

Establish Communications (Find Rack) 
Verifies communication between the control system and the PC, and 
synchronizes the baud rates when they differ. 
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With an RS-232 connection, Viewport checks baud rates, beginning with 
115200 and cycling back to 300 until the control system is detected. When the 
control system is found it is set to the same baud rate as the PC. 

With a TCP/IP connection, the “Communication” window displays the IP 
address and port number of the control system.  

If the control system cannot be located, an error message is displayed. 

Check Operating System Version 
Displays the current version of the operating system (Ops) as well as the date 
that the operating system was uploaded. The Ops version number includes a 
suffix that indicates the type of control system, as follows: 
  

Suffix Control System 

s Smartouch 

m CNMS 

l Lighting 

c Rack or Card Cage 

x CNX  

w CNRACKX 

The 2-Series processor has no associated suffix; rather, the operating system 
version will be preceded by the model name of the control system. 

Report Plug-in Control Cards 
Identifies all cards that are installed in the control system, in the following 
format (internal cards report as if they were plug-in cards): 

7:89 CNMSX     Internal Relays 

The first number corresponds to the card slot. (For internal cards this number 
coincides with the slot in SIMPL Windows where the card is said to be located, 
even though it is a fixed card.) The number after the colon is a unique identifier 
that SIMPL Windows uses when it executes an Autofill (found on the SIMPL 
Windows Project menu). 

Report Network Devices 
Identifies all detected network devices. The data includes the Net ID, the name 
and type of device, as well as its operating system or firmware version, where 
applicable. 

Report Program Information 
Displays detailed information about the SIMPL Windows program that is 
currently loaded in the control system. The data includes the program directory 
and source file information, as well as the version numbers of the operating 
system, database, and libraries. 

Get Available Mailbox Size 
Displays the current capacity of the mailbox and the name of any file that is 
currently being stored in the mailbox. 
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The control system mailbox is a region of memory that is designed to store one 
file at a time, typically the source file for the SIMPL Windows program.  

In X-Generation control systems the size of the mailbox is fixed, whereas in the 
2-Series (and pre-X-Generation) the size varies depending on the amount of 
memory left over after the SIMPL Windows program has been uploaded.  

• In X-Generation processors, the contents of the mailbox is deleted 
whenever a new program is uploaded to the control system, or a new 
file is saved to the mailbox. 

• In 2-Series processors, the contents of the mailbox is deleted only when 
a new file is saved to the mailbox; uploading a new program will not 
erase the file. 

NOTE:  On X-Generation and 2-Series the mailbox size varies, depending on 
the amount of memory left over after the SIMPL Windows program has been 
uploaded. On some 2-Series processors (PRO2, AV2, and CNX-DVP4) the 
amount of memory can be expanded with compact flash. 

Identify Transmitter ID 
Verifies communication between an infrared (IR) or radio frequency (RF) 
transmitter and a receiver, such as the CNIRGW or CNRFGWA. 

NOTE:  The control system program must contain a gateway at the ID where 
the physical gateway is located. 

Simply point the transmitter at the receiver and press any button; if valid 
communication exists, the Transmitter ID of the unit will be displayed, and the 
Button ID field will show the ID of the button that was pressed. 

Switch Processors (CNRACKX-DP) 
Used with the CNRACKX-DP (dual processor) to switch communication from 
one processor to the other. 

Viewport: Functions Menu 
 
The Functions menu consists of commands for resetting and restarting the 
system, and for specifying control system and touchpanel settings. 

CNX/CN Series 

Soft Reset 
Restarts the program that is currently loaded in the control system's working 
memory, or RAM. 

Hard Reset 
Loads the program that is in permanent memory, or flash PROM, into RAM. 
This will overwrite whichever program was previously in RAM. 
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Cold Reboot 
Re-initializes Monitor ROM (a set of system-level routines similar to the BIOS) 
and restarts the operating system. 

Boot from ROM 
Re-initializes EPROM (CN-Series only). 

Erase Permanent Memory 
Erases the program that is currently stored in flash PROM. 

Erase SIMPL+ Directory 
Erases all SIMPL+ modules stored in flash PROM. 

Erase Everything Except the Monitor 
Erases all memory (flash PROM, RAM, NVRAM, and SIMPL+) except for 
Monitor ROM (a set of system-level routines similar to the BIOS). 

Show SIMPL+ Memory Usage (CNX Only) 
Displays the Tasks List, which is the list of SIMPL+ tasks/processes running in 
the control system (X-Generation only).  

The data includes the amount of memory being used by each SIMPL+ module, 
as follows: 

 
The ROM column represents how much permanent memory the module is 
taking up in the control system. A module is stored only once. In the example 
above, three modules are stored in ROM: 

• BRAND X VCR CONTROL.UF takes up 144 bytes of ROM. 

• BRAND Y VCR CONTROL.UF takes up 128 bytes of ROM. 

• BRAND Z VCR CONTROL.UF takes up 384 bytes of ROM. 

A module can be instantiated several times; each instance of a module takes up 
RAM (as shown in the RAM column), but no additional ROM. In the above 
example, BRAND X VCR CONTROL.UF is instantiated five times. Each 
instance takes up the same amount of RAM. 

The name in parentheses is the reference name. In SIMPL Windows, all 
SIMPL+ modules have a <Reference Name> parameter. Whatever is typed into 
this field is what will be shown in the parentheses. This provides a unique 
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identifier for each copy of a module. If any errors are generated at runtime, the 
error message will give both the module name and the reference name, as 
follows: 

~TEMP1[7] <-- Array out of bounds in BRAND Z VCR 
CONTROL.UF (Executive Planning Room) 

~TEMP[16][17] <-- Array out of bounds in BRAND Z 
VCR CONTROL.UF (Executive Planning Room) 

~X$[10] <-- Array out of bounds in BRAND Z VCR 
CONTROL.UF (Executive Planning Room) 

The reference name makes it easier to track the instance of a module that is 
causing the run-time error. 

The Handle column is used internally by the control processor and can be 
disregarded. The <none> task is a system internal task that is always present. 

2-Series 

Program Reset 
Restarts the program stored in permanent memory, or flash PROM. If programs 
exist both in internal and Compact Flash memory, the program in Compact 
Flash will be loaded. Otherwise, the program in internal memory is loaded.  
 
Use the console command "CFAUTORUN ON/OFF" to control the actions of 
the control system when a Compact Flash card is inserted into a running system. 
If CFAUTORUN is enabled, when a Compact Flash card is inserted or removed 
the system automatically performs a program reset and the program in Compact 
Flash will run. If CFAUTORUN is disabled, then a program reset must be 
issued to switch programs. 

If programs exist both in internal and Compact Flash memory, the program in 
Compact Flash will be loaded. Otherwise, the program in internal memory is 
loaded. 

Control System Reboot 
Restarts the control system and reloads the program that is currently stored in 
memory. If programs exist both in internal and Compact Flash memory, the 
program in Compact Flash will be loaded. Otherwise, the program in internal 
memory is loaded. 

Erase Program 
Erases the current program. 

If the Viewport detects a program in Compact Flash, then click Yes to erase the 
program from Compact Flash, or No to erase the program from internal 
memory. Click Cancel to cancel the operation. 

Erase Web Pages 
Deletes all Web pages from the internal Web server or Compact Flash.  

If the Viewport detects Web pages in Compact Flash, then click Yes to erase the 
Web pages from Compact Flash, or No to erase Web pages from internal 
memory. Click Cancel to cancel the operation. 
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Error Log 
Provides options for retrieving and saving the error messages that are shown on 
the front panel of 2-Series control systems (when you press the MSG button on 
the front panel of the control system). 

• To display the current error messages in Viewport, click Show Error 
Log.  

• To write the error messages to the Clipboard, click Copy Error Log to 
Clipboard.  

• To save the error messages to a file, click Save Error Log to File. 
Then locate the desired target directory, name the file and click Save. 

• Finally, to erase the front panel error messages, click Clear Error Log. 

General 

Send Break 
Issues a break command to the COM port. (Another way to issue the break 
command in Viewport is to press Alt+K.) 

A break key tells a computer to halt, or break out of, whatever it is doing. On 
most PCs, for instance, pressing the Pause/Break or Scroll Lock/Break key 
while holding down the Ctrl key issues the break command. 

Set Baud Rate 
Sets the baud rate for serial communication between the PC and the control 
system. Select the baud rate and click OK. 

The default baud rate differs depending on the control system. For 2-Series 
processors, the default baud rate is 115200; for X-Generation, the default is 
57600. 

Set Control System Clock 
Sets the control system's internal clock and calendar. Enter the date and time (in 
24-hour format) and click OK. Alternatively, you can set the time and date 
using the Time menu on the front panel of the control system. Access to this 
menu requires a password (refer to the following “Set Front Panel Password”). 

The time and date are accessed by the Clock Driver symbol to make the internal 
clock available to other logic symbols, as well as to synchronize the internal 
clocks of touchpanels with the control system. 

Set Front Panel Password 
The front panel password is a four-digit access code that permits access to the 
Time menu on the front panel of X-Generation and 2-Series control systems, for 
purposes of setting the internal clock and calendar.  

The factory-set access code is 1-2-3-4; to set a new code, select the four 
numbers from the drop-down lists. 

Set Control System IP Information 
Sets the control system's IP address, IP mask and default router IP address. 
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Setup IP Table 
The IP Table is an internal table that contains the IP IDs and IP addresses of all 
Ethernet network devices defined in a program 

1. Click Add and select the IP ID of each device from the drop-down list. 
Enter the IP address in the IP Address text fields and click OK to add 
the entry to the IP Table editor. The entry will be preceded by a  
icon, denoting that it has not yet been uploaded to the control system.  
 
The Set as Master check box pertains only to the following control 
systems: the CEN-TVAV, CEN-CN and all 2-Series control systems. 
These units can be slaved to other control systems. Here the IP Table of 
the master control system must include the IP ID and IP address of each 
slave device. 
 
Similarly, the IP Table of the slave device must have an entry for the 
master control system. This is accomplished through the following 
settings:  

a) The IP ID is the IP ID of the slave device itself, as listed in the 
IP Table of the master control system.  

b) The IP address is the address of the master control system.  

c) The Set as Master check box must be selected. 

 
After the master control system has been added to the IP Table editor, 
the Master? field will read True (the only instance where this field will 
read True). Only one entry in the IP Table can be listed as Master. 

2. After all the device IP IDs and associated IP addresses have been added 
to the editor, click Send IP Table to Control System. Each entry will 
now be preceded by a  icon, denoting that it has been uploaded to 
the control system. 

Once the IP Table has been uploaded to the control system its entries can be 
modified or removed: 

• To view the IP Table that is currently loaded in the control system, 
click Retrieve Current IP Table from Control System. All the 
entries will be displayed in the IP Table editor, preceded by a  icon. 

• To remove an entry from the IP Table editor, select it and click 
Remove. To erase the contents of the IP Table editor, click Remove 
All. Note that entries will not actually be removed from the IP Table 
until the new IP Table is sent to the control system. 

• To change an entry, select it and click Modify. Make the desired 
changes to the IP ID or IP address and click OK. The modified entry 
will now appear in the IP Table editor preceded by a  icon. 

• To add a new entry, click Add and enter the IP information. The new 
entry will appear in the IP Table editor preceded by a  icon.  

• To erase the IP Table that is currently loaded in the control system, 
click Clear Current IP Table in the Control System. 

• To save the contents of the IP Table editor to a file, select Save to 
Disk, browse to the desired directory, name the file and click Save. To 
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retrieve IP Table data that has been saved to disk, click Load from 
Disk, browse to the file and click Open. 

• To upload the IP Table to the control system, click Send IP Table to 
Control System. 

Set TCP/IP Console Password 
The TCP/IP console password restricts TCP/IP access to the control system. The 
password can be set using either an RS-232 or TCP/IP connection. Simply enter 
the password in the New Password field and then re-enter the password in the 
Verify field. 
 
Click Disable Password to allow unrestricted access to the control system. 

Set Network ID 
Sets the Network IDs of certain network devices. Not all Net IDs can be 
changed in this way; some devices have different hardware settings, and some 
touchpanels must be configured locally. Refer to the hardware manual of the 
device to verify whether its Net ID can be changed using Viewport. 

As Viewport detects network devices, those devices will be listed in Current 
Network Devices. The information given here includes the current Net ID of the 
device, the type of device and its firmware version. Click Search for Devices to 
refresh this list if any devices are added or removed from the network. To 
change the Net ID select the device, choose a Net ID from the drop-down list, 
and then click Set ID. 

To send the Set ID command directly to a single device, click the Broadcast to 
All ID's check box and connect only that device to the network. Select a new ID 
as just described, and click Set ID. 

Set Transmitter ID 
Sets the ID of an infrared (IR) transmitter. This requires a CNIDC (IR probe).  

First enter the two-digit hexadecimal ID that the transmitter will be set to and 
click OK. Position the IR probe of the CNIDC over the sensor on the transmitter 
and click OK to begin programming. Continue to hold the IR probe in position 
until the LED indicator on the transmitter stops flashing. 

To verify the new ID, click Identify Transmitter ID on the Viewport 
Diagnostics menu.  

Set RFGWX Channel 
Sets the radio frequency (RF) channel of a CNRFGWX (two-way transceiver for 
STX Spectrum touchpanels) and STRFGWX (two-way transceiver for the STX-
1700C touchpanel).  

Each transceiver in a system requires a unique hexadecimal RF channel; 
Crestron provides 16 channels ranging from 00 to 0F. 

First select the Net ID of the transceiver, then select the desired RF channel. To 
verify the new channel, click Report Network Devices on the Diagnostics 
menu. 
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Put Touchpanel into Setup Mode/Calibrate Mode 
To bring a network touchpanel into setup mode or calibrate mode, simply enter 
the Net ID of the panel and click OK.  

To bring all touchpanels on the network into setup or calibrate mode, enter "FF" 
as the Net ID. 

Enter Passthrough Mode 
Passthrough Mode allows direct access to serial devices. That is, it allows direct 
communication between the PC and a network serial device (effectively 
"passing through" the control system).  

To establish communication, select the connection type that exists between the 
control system and the device. The choices are Slot (for devices connected to the 
control system via one of the card slots on the back panel), Cresnet, or Ethernet. 
If the connection is through a card slot then select the slot number from the Slot 
drop-down list. For Cresnet, select the Cresnet ID of the device; for Ethernet, the 
IP ID. Note that the IP ID and associated IP address of the Ethernet device must 
be listed in the control system's IP Table. 

Specify the port (Port A through Port F) that the device is connected to, if 
applicable. 

Next, specify the serial settings that the device expects, including the baud rate, 
parity, data bits and stop bits, and handshaking. (This information should be 
provided by the manufacturer's documentation.) 

The procedure for exiting passthrough mode differs depending on the control 
system. For X-Generation control systems, enter a "timeout" for the connection 
to be terminated after being idle (the maximum timeout is five minutes). 
Alternatively, use the Ctrl+C console command to exit passthrough mode 
explicitly. 

For 2-Series control systems, simply click Exit Passthrough Mode on the 
Functions menu. 

Exit Passthrough Mode (2 Series) 
Takes Viewport out of passthrough mode (2-Series only). 

Configure CNXTA Telephone Audio Interface Card 
Uploads WAV files to the CNXTA card, Crestron's telephone interface to X-
Generation and 2-Series control systems. The WAV files typically provide voice 
prompts and responses, and must be saved in PCM format at 8000 Hz, 16 bit, 
monaural (mono). (You can use the Windows Sound Recorder to record and 
save WAV files in the proper format.) 

First select the slot where the CNXTA is installed, or click the Offline check box 
to configure the card offline and click OK. 

If the CNXTA is connected, any WAV files that have been uploaded to the card 
will be displayed in order (from File# 1 up to File# 127) in the File List. Each 
entry will be preceded by a  icon, denoting that the file resides on the card, 
rather than on disk. The total length of the files (in minutes) as well as the 
amount of space available on the card will be given in the status window. Note 
that the CNXTA can store about 40 minutes of WAV files. Individual WAV 
files can have a maximum length of about four minutes. 
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If the configuration is offline, then the File List will display 127 blank entries. 

To add WAV files to the file list, double-click a blank entry (or right-click a 
blank entry and select Choose File). Browse to the WAV file and click Open. If 
the file is in the supported format (PCM, 8000 Hz, 16 bit, mono) it will be added 
to the file list preceded by a  icon, denoting that the file resides on disk, 
rather than on the CNXTA card. The information here includes fields for File# 
(position), Name, Date, and Length in seconds. (If the file is not in the supported 
format an error message will be generated.) 

To hide blank entries, click Hide Empty File Positions. To display the full path 
of each WAV file click Show Full Path for Files on Disk. 

When all the desired WAV files have been added to the file list, they can be 
uploaded to the CNXTA simply by clicking Send New Files to CNXTA while 
working in online mode. 

To change the position of a file in the list, right-click it and select Move. Then 
choose an unoccupied position and click OK. 

To remove a file from the list, right-click it and select Delete. 

Entire file lists can be saved and retrieved by using the Export and Import File 
List commands. To save a file list, click Export File List and browse to the 
target directory, then name the file and click Save. It will be saved as an XTA 
file. 

To retrieve an XTA file, click Import File List, browse to the file and select it. 
Here the Count field will display the number of WAV files in the selected XTA 
file, while File Position Range will display the range of positions. For example, 
an XTA file might hold five WAV files, taking up positions 1 through 5. Click 
Open to add the entries to the file list. 

Sometimes multiple XTA files must be uploaded to the CNXTA. It is possible 
that the entries in one file list will overlap with those in another file list. With 
the example just described, there may be a second XTA file holding seven WAV 
files that take up positions 1 through 7. To accommodate this second file list, 
enter an offset value of 5 in the Offset File Position field. This will move the 
entries up five positions, so that the new range will be from position 6 through 
position 12. 

Assign Serial Number 
Function not yet defined. 

Assign Cresnet ID by Serial Number 
Function not yet defined. 

Serial Number/TSID Conversion Tool 
Function not yet defined. 

e-Control 2 Activation 
Function not yet defined. 
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Viewport: File Transfer Menu 
The File Transfer menu lists commands for updating, sending, and retrieving 
files. 

Send Program 
Uploads the compiled SIMPL Windows program to the control system. Click 
Browse, select the file and click Open. This will display the program's header 
information and enable one or both of the What to Send check boxes. If the 
program does not contain any SIMPL+ modules only the SIMPL Program check 
box will be enabled. If it does contain SIMPL+ modules, then the SIMPL+ 
Program(s) check box will also be enabled. Select one or both check boxes and 
then click Send Program to begin the transfer. 

With X-Generation processors, to store the program in permanent memory 
(flash PROM) click Make Permanent. This will overwrite the previous 
contents of flash PROM.  

With 2-Series processors, a permanent memory image is not required. The 2-
Series provides the option to retrieve the current program from the control 
system before overwriting it. Simply select the Retrieve Current Program check 
box.  

Each uploaded program is added to the New Program drop-down list. This 
makes it convenient to resend a program without need to browse to a directory. 
To delete the list click Clear History. 

Click Check Program to display the header information of the program that is 
currently loaded in the control system. 

Send Touchpanel 
Uploads a compiled Crestron VisionTools® Pro-e project file to a touchpanel. 
First select the Net ID of the panel and click OK. Alternatively, click Send 
Direct to Wired Touchpanel if the touchpanel is connected directly to a COM 
port on the PC, or if you are connected to a TPS-5000 or TPS-6000 via Ethernet. 

• For non-TPS panels, browse to the .hex file and click Open to begin 
the transfer.  

• For TPS panels, browse to the .vtz file and click Open. This will 
display the full file path, as well as the date the project was compiled.  

Next, choose the pages to send to the TPS panel. The choices are as follows: 

All Files in Project: sends the entire project. 

Only Changed Files: sends only the files that are different from those that are 
currently stored in the panel. Note that if any pages in the panel are not present 
in the project, those pages will be deleted from the panel. 

Additional choices include Do Not Send Graphic Files and Do Not Send Sound 
Files. These are often very large files that can take a long time to upload. 

Each uploaded project is added to the File Name drop-down list. This makes it 
convenient to resend projects without need to browse to a directory. To delete 
the list click Clear History. 
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Send Web Pages 
Uploads Web pages to X-Generation and 2-Series control systems. With X-
Generation control systems, the Web server is a built-in component of the 
CNXENET+ card, providing up to 2.0 MB of storage for Web pages.  

With 2-Series control systems, the Web server is built into the control processor 
itself; thus, with its expandable slot for compact flash memory, the 2-Series can 
accommodate practically any memory requirement. Although Web pages can be 
uploaded to the 2-Series control systems without need for any other hardware, a 
C2ENET-1 or C2ENET-2 card is required for Ethernet access and 
communication for AV2 and PRO2. 

Send Generic Files (2-Series Only) 
Transfers files to a specified directory in the control system. 

Before sending files, the target directory must be open. Use the DIR and CD 
console commands to access directories. For example: 

• Type DIR to view the contents of the current directory. The root 
directory is shown below. Note that the Compact Flash directory is 
listed as CF0. 

• To change directories, type CD <Directory>.  

• To create a new directory (only in Compact Flash), open the CF0 
directory and type MAKEDIR <New Directory>. 

When the target directory is open, use the Send Generic Files command to 
browse to the file. Click Open to transfer the file. 

Following is a list of console commands that work with the Compact Flash 
directory: 

• CFAUTORUN: enables a program autoboot from Compact Flash. 

• MAKEDIR: creates a directory on Compact Flash. 

• CD: changes to a directory on Compact Flash. 

• DELETE: deletes specified files from Compact Flash. 

• DIR: lists the files in Compact Flash. 

• FREE: If Compact Flash is the current directory, displays the amount 
of space available on the Compact Flash card. If internal, gives the 
amount left on internal flash. 

• XGETFILE: retrieves a file from Compact Flash. 

• XPUTFILE: sends a file to Compact Flash. 

VisionTools Pro-e Browser Projects 
In most cases, the HTML files that are uploaded to a control system are 
generated in a VisionTools Pro-e browser project. Whenever a browser project 
is compiled, VisionTools Pro-e automatically creates a folder in the Projects 
directory with the name of the project and a .web extension. This .web project 
folder itself contains a Java subfolder, in addition to all the HTML pages that 
will be sent to the control system. 

In designing and creating a browser project, it is necessary to assign an IP ID to 
all the project pages and to specify the IP address of the control system. This is 
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accomplished by using the Web tab of the VisionTools Pro-e “Project 
Properties” window. Choose an IP ID from the drop-down list and enter the IP 
address of the control system. Then click Apply Settings to All Pages. 
(Alternatively, the IP information can be specified at the page level using the 
Web tab of each “Page Properties” window.) 

SIMPL Windows 
For each IP ID in the browser project, there must be one corresponding Crestron 
e-Control® PC Interface symbol defined in the SIMPL Windows program. This 
symbol is identical to a touchpanel symbol, except that the User interface it 
represents is a Web browser rather than a touchpanel. 

Since the PC Interface symbol is considered an Ethernet device, it must receive 
an entry in the control system's IP Table. Here the IP ID must match the IP ID 
that was assigned to the project pages in VisionTools Pro-e, while the IP address 
is determined by the type of e-Control gateway being used: with the hardware 
gateway that is built into the CNXENET+ or C2ENET cards the IP address must 
be set to localhost: 127.0.0.1. With the CNX software gateway, enter the IP 
address of the PC where the gateway is installed. 

Viewport 
To upload Web pages, click Send Web Pages. The options are to send an entire 
project, only files that have changed, or a single HTML file. With the Transfer 
Entire Project option, click OK when reminded to select a default page, then 
browse to the VT Pro-e WEB folder. Select the file that was designated as the 
"first" page of the project. This will be the default Web page that is displayed 
whenever the IP address of the control system is accessed by a Web browser. 
Click Open, and then OK to begin the transfer. 

If any files in the project change, the changed files can be transferred to the 
control system without need to resend the entire project by selecting Only 
Transfer Files that have Changed. Here again, browse to the WEB folder and 
select the default page. Click Open, and then OK to transfer the changed files. 

NOTE:  During transfer, Viewport compares the files in the VisionTools Pro-e 
project with those on the Web server. If the Web server contains files that are 
not present in the project, those files will be deleted from the Web server.  

Finally, a single HTML file can be sent by selecting Transfer Single File. 
Browse to the file and click Open. Then specify the file's relative path (from the 
root directory) and click OK. 

Send File to Mailbox/Get File from Mailbox 
Send or retrieves a file from the control system mailbox, a region of memory 
that is designed to store one file at a time, typically the source file for the 
SIMPL Windows program. To send a file to the mailbox, simply browse to the 
file and click Open. To save the contents of the mailbox to a file, browse to the 
desired target directory and click Save. 

The size of the mailbox varies, depending on the amount of memory left over 
after the SIMPL Windows program has been uploaded. To display the current 
capacity of the mailbox in kilobytes click Get Available Mailbox Size on the 
Diagnostics menu. This will also display the name of any file that is currently 
being stored in the mailbox. 
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NOTE:  In X-Generation processors, the content of the mailbox is deleted 
whenever a new program is uploaded to the control system, or a new file is 
saved to the mailbox.  In 2-Series processors, the mailbox content is deleted 
only when a new file is saved to the mailbox; uploading a new program will not 
erase the file. 

NOTE: On some 2-Series processors (PRO2, AV2, and CNX-DVP4) the 
amount of memory can be expanded with compact flash. 

Load/Save NVRAM from File 
Save or retrieves the contents of NVRAM (non-volatile memory) to an NVR 
file. This is typically used for data backups. By default, the NVR file is saved to 
the SIMPL Windows Program directory. 

Update Control System 
Sends control system upgrades to the processor. Updates for X-Generation 
processors are contained in UPZ files; those for 2-Series processors, in CUZ 
files. Sometimes upgrades must be extracted from .zip files. 

Updates are obtained from the Crestron Web site. To download an update, click 
the file and choose the Save to Disk option, then specify the target directory. If 
the update is zipped, extract all the zipped files to the same directory and review 
any "Readme" documentation before continuing with the upload procedure. 

Once the update has been downloaded, the available options for uploading the 
files differ depending on the control system. 

With the 2-Series processor, simply browse to the CUZ file and click Open to 
start the transfer. 

With the X-Generation processor, the Current text fields display the version 
numbers of the various files that are currently loaded in the control system. 
These version numbers often differ from each other since some files, such as 
Monitor ROM, are rarely updated whereas other files, such as the operating 
system, are updated more often. 

Browse to the UPZ file and click Open. The version numbers for this new UPZ 
file and the updates it contains will be listed in the Selected text fields. (Here 
again, the version numbers are likely to differ.) 

Next, verify that all three What to Send check boxes are selected: Operating 
System, Monitor, and TCP/IP Stack. Selecting all three update files ensures 
optimum system performance and compatibility with future updates. Finally, 
click Send to upload the files to the control system. 

NOTE: In some cases Microsoft's Internet Explorer may append a .zip 
extension to a downloaded .cuz or .upz file. For example, a file called 
"51263x.upz" may appear as "51263x.upz.zip." If this happens, rename the file, 
removing the .zip extension. 

Update Touchpanel Firmware 
Sends firmware upgrades to touchpanels. All updates are contained in CSF files, 
but some must be extracted from ZIP files, while others are contained in self-
extracting EXE files. 
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Updates are obtained from the Crestron Web site. To download an update, click 
the file and choose the Save to Disk option, then specify the target directory. If 
the update is zipped, extract all the zipped files to the same directory and review 
any "Readme" documentation before continuing with the upload procedure. 

To send the update, select the Network ID of the touchpanel. Alternatively, click 
Send Direct to Wired Touchpanel if the touchpanel is connected directly to a 
COM port on the PC or a TPS-5000/6000 connected via Ethernet. Browse to the 
file and click Open. Note that if the upgrade was extracted from a ZIP file, then 
there may be two files, an "a" file and a "b" file. Choose the "a" file; Viewport 
will automatically retrieve the "b" file during the upload. 

Load Network Device 
Uploads firmware upgrades to network devices. These updates are contained in 
UPG files, although in many cases upgrades must be extracted from ZIP files. 

Updates are obtained from the Crestron website. To download an update, click 
the file and choose the Save to Disk option, then specify the target directory. If 
the update is zipped, extract all the zipped files to the same directory and review 
any "Readme" documentation before continuing with the upload procedure. 

To upload the update, select the Network ID of the device and click OK. Then 
browse to the UPG file and click Open. 

Update Plug-in Card 
Uploads firmware upgrades to control cards installed in the control system. 
These updates are contained in UPG files, although in many cases upgrades 
must be extracted from .zip files.  

Updates are obtained from the Crestron website. To download an update, click 
the file and choose the Save to Disk option, then specify the target directory. If 
the update is zipped, extract all the zipped files to the same directory and review 
any "Readme" documentation before continuing with the upload procedure. 

To send the update, select the slot where the card is installed and click OK. 
Then browse to the UPG file and click Open. 

Retrieve Program (2 Series) 
Creates an "SPZ" SIMPL Windows source file from the program that is 
currently loaded in the control system (2-Series only). 

General File Transfer 
Provides options for transferring files in cases where the Viewport operates as a 
generic terminal emulator. 

The Choose File command provides quick access to a file. Before beginning the 
file transfer, browse to the file and click Open. This will make the file 
immediately available for selection when the file transfer operation begins. 

Send SIMPL+ Program to the CEN-OEM 
Uploads a SIMPL+ module (CSZ file) to the Crestron CEN-OEM, a device that 
provides Ethernet capability to third party serial devices. The module translates 
the serial protocol used by the third party device into standard Crestron digital, 
analog and serial signals. 

Locate the SIMPL+ directory containing the CSZ file and click Open. 
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Send Touchpanel (MT-500C only) 
Function not yet defined. 

Viewport: Remote Menu 
The Remote menu provides options for communicating with remote systems via 
modem, RS-232 or TCP/IP.  

Modem 
Provides options for connecting via modem to a computer or control system. 

NOTE:  The Modem Settings command on the Viewport Setup menu specifies 
the initialization strings for a PC or control system modem, as well as for any 
modem used in PC Passthrough mode. (An initialization string is sent to a 
modem in order to configure and prepare it for use.) Viewport provides default 
initialization strings that are standard for most modems. In addition, Modem 
Settings specifies the time to wait for a connection to be established before 
hanging up.  

To begin a dial-up connection, click Dial and enter the number to be dialed 
(hyphens are permitted); to terminate the connection, click Hang Up. 

Use Phone Book to store frequently dialed numbers. Click Add to enter a new 
number in the phone book, enter the name and comments in the text fields and 
click Save to add the number to the list of entries. To change an entry, select it 
and click Modify; to remove an entry, select it and click Delete. Use the Copy 
command to make minor modifications to an entry without need to re-type all 
the information. To dial a number in the phone book, simply select it and click 
Dial. 

Use the Initialize Rack Modem command to configure a control system 
modem (the control system must be connected to a COM port on the PC). The 
modem will be configured using the initialization string specified in Setup | 
Modem Settings. 

TCP/IP 
Provides options for connecting to a computer or control system via Ethernet. 
Simply click Connect and enter the IP address and port number of the desired 
destination (if connecting to a control system, it may be necessary to enter a 
password); to terminate communication, click Disconnect (this will restore 
default TCP/IP settings). 

Each time a new IP address is entered in the IP Address field, it is added to the 
IP Address drop-down list. This makes it convenient to connect to frequently 
used addresses, as they can simply be selected from the list without need to 
retype. To delete the list click Clear Connect History. 

Use Address Book to store frequently used IP addresses. Click Add to enter a 
new IP address, enter the name and comments in the text fields and click Save to 
add the IP address to the list of entries. To change an entry, select it and click 
Modify; to remove an entry, select it and click Delete. Use the Copy command 
to make minor modifications to an entry without need to re-type all the 
information. To connect to an IP address, select it and click Connect. 
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Some IP addresses (usually hosts on the Internet) have associated domain 
names. The DNS Lookup command retrieves the domain name, if any, of the 
current IP address.  

The Wait for Connection command causes the Viewport to listen for a TCP/IP 
connection to be initiated from another control system or computer. Enter the 
port number and click OK. To take Viewport out of listening mode, click 
Cancel. 

PC Passthrough 
PC Passthrough refers to a communication method whereby a remote PC 
connects to a local control system by using a local PC as a bridge. This is 
typically used in troubleshooting situations where a programmer must access a 
customer's control system from outside the customer's LAN. Since the control 
system is likely to be protected behind a firewall, Internet access will not be 
possible. 

In this scenario a local PC can establish communication with the control system 
using RS-232 or TCP/IP, as usual. The local PC would then enter PC 
Passthrough mode. The remote PC then connects to the local PC, usually via 
modem, enabling the remote PC to communicate with the control system just as 
if a direct connection existed. 

Remote Console 
Enables access to the console of a network device, such as a TPS touchpanel or 
CNTV. Click Connect and then enter the Net ID of the device to be accessed, 
then click OK. Once the connection is established commands can be issued 
directly to that device console from Viewport. To terminate communication, 
click Disconnect. 
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Viewport: Shortcut Keys 
 

Shortcut Key Viewport Function 

Alt+X Exit 

Ctrl+Insert Copy 

Ctrl+Shift Paste 

Alt+C Clear Data 

Alt+L Local Echo 

Alt+H Display in Hex Mode 

Alt+W Split Window 

Alt+D Communication Settings 

Alt+B Establish Communications 

F5 Check Operating System Version 

F3  Report Plug-in Control Cards 

F4 Report Network Devices 

F7 Report Program Information 

Alt+R Identify Transmitter ID 

F9 Soft Reset (X-Generation) 

F10 Hard Reset (X-Generation)  
Program Reset (2-Series) 

Alt+K Send Break 

F8 Set Baud Rate 

F6 Set Control System Clock 

Alt+P Send Program 

Alt+T Send Touchpanel 

Alt+O Update Control System 

Alt+U XModem 1K Upload 

Alt+A Address Book 

Alt+0 through Alt+9 User-specified presets for communication settings 

Ctrl+F1 through 
Ctrl+F10 Send User-specified serial strings to the COM port 
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ASCII Conversions 
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Further Inquiries  
If after reviewing this Reference Guide, you cannot locate specific information 
or have questions, please take advantage of the Crestron award winning 
customer service team by calling:  

• In the US and Canada, call the Crestron corporate headquarters at  
1-888-CRESTRON [1-888-273-7876].  

• In Europe, call Crestron International at +32-15-50-99-50. 

• In Asia, call Crestron Asia at +852-2341-2016. 

• In Latin America, call Crestron Latin America at  
+5255-5093-2160. 

• In Australia and New Zealand, call Crestron Pacific at 
+613-9480-2999. 

You can also log onto the online help section of the Crestron website 
(www.crestron.com) to ask questions about Crestron products. First-time users 
will need to establish a user account to fully benefit from all available features. 
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Software License Agreement 
This License Agreement (“Agreement”) is a legal contract between you (either an individual or a single business entity) 

and Crestron Electronics, Inc. (“Crestron”) for software referenced in this guide, which includes computer software and, as 
applicable, associated media, printed materials, and “online” or electronic documentation (the “Software”). 

BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE, YOU REPRESENT THAT YOU ARE 
AN AUTHORIZED DEALER OF CRESTRON PRODUCTS OR A CRESTRON AUTHORIZED INDEPENDENT 
PROGRAMMER AND YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE 
TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE. 

IF YOU HAVE PAID A FEE FOR THIS LICENSE AND DO NOT ACCEPT THE TERMS OF THIS AGREEMENT, 
CRESTRON WILL REFUND THE FEE TO YOU PROVIDED YOU (1) CLICK THE DO NOT ACCEPT BUTTON, (2) DO 
NOT INSTALL THE SOFTWARE AND (3) RETURN ALL SOFTWARE, MEDIA AND OTHER DOCUMENTATION AND 
MATERIALS PROVIDED WITH THE SOFTWARE TO CRESTRON AT:  CRESTRON ELECTRONICS, INC., 15 VOLVO 
DRIVE, ROCKLEIGH, NEW JERSEY  07647, WITHIN 30 DAYS OF PAYMENT. 

LICENSE TERMS 
Crestron hereby grants You and You accept a nonexclusive, nontransferable license to use the Software (a) in machine 

readable object code together with the related explanatory written materials provided by Creston (b) on a central processing unit 
(“CPU”) owned or leased or otherwise controlled exclusively by You, and (c) only as authorized in this Agreement and the 
related explanatory files and written materials provided by Crestron.  

If this software requires payment for a license, you may make one backup copy of the Software, provided Your backup 
copy is not installed or used on any CPU. You may not transfer the rights of this Agreement to a backup copy unless the installed 
copy of the Software is destroyed or otherwise inoperable and You transfer all rights in the Software.  

You may not transfer the license granted pursuant to this Agreement or assign this Agreement without the express 
written consent of Crestron. 

If this software requires payment for a license, the total number of CPU’s on which all versions of the Software are 
installed may not exceed one per license fee (1) and no concurrent, server or network use of the Software (including any 
permitted back-up copies) is permitted, including but not limited to using the Software (a) either directly or through commands, 
data or instructions from or to another computer (b) for local, campus or wide area network, internet or web hosting services; or 
(c) pursuant to any rental, sharing or “service bureau” arrangement. 

The Software is designed as a software development and customization tool. As such Crestron cannot and does not 
guarantee any results of use of the Software or that the Software will operate error free and You acknowledge that any 
development that You perform using the Software or Host Application is done entirely at Your own risk. 

The Software is licensed and not sold. Crestron retains ownership of the Software and all copies of the Software and 
reserves all rights not expressly granted in writing.  

OTHER LIMITATIONS 
You must be an Authorized Dealer of Crestron products or a Crestron Authorized Independent Programmer to install or 

use the Software. If Your status as a Crestron Authorized Dealer or Crestron Authorized Independent Programmer is terminated, 
Your license is also terminated. 

You may not rent, lease, lend, sublicense, distribute or otherwise transfer or assign any interest in or to the Software. 
You may not reverse engineer, decompile, or disassemble the Software. 
You agree that the Software will not be shipped, transferred or exported into any country or used in any manner 

prohibited by the United States Export Administration Act or any other export laws, restrictions or regulations (“Export Laws”). 
By downloading or installing the Software You (a) are certifying that You are not a national of Cuba, Iran, Iraq, Libya, North 
Korea, Sudan, or Syria or any country to which the United States embargoes goods (b) are certifying that You are not otherwise 
prohibited from receiving the Software and (c) You agree to comply with the Export Laws.  

If any part of this Agreement is found void and unenforceable, it will not affect the validity of the balance of the 
Agreement, which shall remain valid and enforceable according to its terms. This Agreement may only be modified by a writing 
signed by an authorized officer of Crestron. Updates may be licensed to You by Crestron with additional or different terms. This 
is the entire agreement between Crestron and You relating to the Software and it supersedes any prior representations, 
discussions, undertakings, communications or advertising relating to the Software. The failure of either party to enforce any right 
or take any action in the event of a breach hereunder shall constitute a waiver unless expressly acknowledged and set forth in 
writing by the party alleged to have provided such waiver.  
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If You are a business or organization, You agree that upon request from Crestron or its authorized agent, You will 
within thirty (30) days fully document and certify that use of any and all Software at the time of the request is in conformity with 
Your valid licenses from Crestron of its authorized agent. 

Without prejudice to any other rights, Crestron may terminate this Agreement immediately upon notice if you fail to 
comply with the terms and conditions of this Agreement. In such event, you must destroy all copies of the Software and all of its 
component parts. 

PROPRIETARY RIGHTS 
Copyright. All title and copyrights in and to the Software (including, without limitation, any images, photographs, 

animations, video, audio, music, text, and “applets” incorporated into the Software), the accompanying media and printed 
materials, and any copies of the Software are owned by Crestron or its suppliers. The Software is protected by copyright laws and 
international treaty provisions. Therefore, you must treat the Software like any other copyrighted material, subject to the 
provisions of this Agreement. 

Submissions. Should you decide to transmit to the Crestron website by any means or by any media any materials or 
other information (including, without limitation, ideas, concepts or techniques for new or improved services and products), 
whether as information, feedback, data, questions, comments, suggestions or the like, you agree such submissions are unrestricted 
and shall be deemed non-confidential and you automatically grant Crestron and its assigns a non-exclusive, royalty-tree, 
worldwide, perpetual, irrevocable license, with the right to sublicense, to use, copy, transmit, distribute, create derivative works 
of, display and perform the same. 

Trademarks. CRESTRON and the Swirl Logo are registered trademarks of Crestron Electronics, Inc. You shall not 
remove or conceal any trademark or proprietary notice of Crestron from the Software including any back-up copy. 

GOVERNING LAW 
This Agreement shall be governed by the laws of the State of New Jersey, without regard to conflicts of laws 

principles. Any disputes between the parties to the Agreement shall be brought in the state courts in Bergen County, New Jersey 
or the federal courts located in the District of New Jersey. The United Nations Convention on Contracts for the International Sale 
of Goods, shall not apply to this Agreement. 

CRESTRON LIMITED WARRANTY 
CRESTRON warrants that:  (a) the Software will perform substantially in accordance with the published specifications 

for a period of ninety (90) days from the date of receipt, and (b) that any hardware accompanying the Software will be subject to 
its own limited warranty as stated in its accompanying written material. Crestron shall, at its option, repair or replace or refund 
the license fee for any Software found defective by Crestron if notified by you within the warranty period. The foregoing remedy 
shall be your exclusive remedy for any claim or loss arising from the Software. 

CRESTRON shall not be liable to honor warranty terms if the product has been used in any application other than that 
for which it was intended, or if it as been subjected to misuse, accidental damage, modification, or improper installation 
procedures. Furthermore, this warranty does not cover any product that has had the serial number or license code altered, 
defaced, improperly obtained, or removed. 

Notwithstanding any agreement to maintain or correct errors or defects Crestron, shall have no obligation to service or 
correct any error or defect that is not reproducible by Crestron or is deemed in Crestron’s reasonable discretion to have resulted 
from (1) accident; unusual stress; neglect; misuse; failure of electric power, operation of the Software with other media not 
meeting or not maintained in accordance with the manufacturer’s specifications; or causes other than ordinary use; (2) improper 
installation by anyone other than Crestron or its authorized agents of the Software that deviates from any operating procedures 
established by Crestron in the material and files provided to You by Crestron or its authorized agent; (3) use of the Software on 
unauthorized hardware; or (4) modification of, alteration of, or additions to the Software undertaken by persons other than 
Crestron or Crestron’s authorized agents. 

ANY LIABILITY OF CRESTRON FOR A DEFECTIVE COPY OF THE SOFTWARE WILL BE LIMITED 
EXCLUSIVELY TO REPAIR OR REPLACEMENT OF YOUR COPY OF THE SOFTWARE WITH ANOTHER COPY OR 
REFUND OF THE INITIAL LICENSE FEE CRESTRON RECEIVED FROM YOU FOR THE DEFECTIVE COPY OF THE 
PRODUCT. THIS WARRANTY SHALL BE THE SOLE AND EXCLUSIVE REMEDY TO YOU. IN NO EVENT SHALL 
CRESTRON BE LIABLE FOR INCIDENTAL, CONSEQUENTIAL, SPECIAL OR PUNITIVE DAMAGES OF ANY KIND 
(PROPERTY OR ECONOMIC DAMAGES INCLUSIVE), EVEN IF A CRESTRON REPRESENTATIVE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR OF ANY CLAIM BY ANY THIRD PARTY. CRESTRON 
MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AS TO TITLE OR INFRINGEMENT OF THIRD-PARTY RIGHTS, 
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE, OR ANY OTHER WARRANTIES, NOR 
AUTHORIZES ANY OTHER PARTY TO OFFER ANY WARRANTIES, INCLUDING WARRANTIES OF 
MERCHANTABILITY FOR THIS PRODUCT. THIS WARRANTY STATEMENT SUPERSEDES ALL PREVIOUS 
WARRANTIES. 
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Return and Warranty Policies 

Merchandise Returns / Repair Service 
1. No merchandise may be returned for credit, exchange, or service without prior 

authorization from CRESTRON. To obtain warranty service for CRESTRON products, 
contact the factory and request an RMA (Return Merchandise Authorization) number. 
Enclose a note specifying the nature of the problem, name and phone number of contact 
person, RMA number, and return address. 

2. Products may be returned for credit, exchange, or service with a CRESTRON Return 
Merchandise Authorization (RMA) number. Authorized returns must be shipped freight 
prepaid to CRESTRON, 6 Volvo Drive, Rockleigh, N.J., or its authorized subsidiaries, 
with RMA number clearly marked on the outside of all cartons. Shipments arriving 
freight collect or without an RMA number shall be subject to refusal. CRESTRON 
reserves the right in its sole and absolute discretion to charge a 15% restocking fee, plus 
shipping costs, on any products returned with an RMA. 

3. Return freight charges following repair of items under warranty shall be paid by 
CRESTRON, shipping by standard ground carrier. In the event repairs are found to be 
non-warranty, return freight costs shall be paid by the purchaser. 

CRESTRON Limited Warranty 
CRESTRON ELECTRONICS, Inc. warrants its products to be free from manufacturing defects in materials 
and workmanship under normal use for a period of three (3) years from the date of purchase from 
CRESTRON, with the following exceptions: disk drives and any other moving or rotating mechanical 
parts, pan/tilt heads and power supplies are covered for a period of one (1) year; touchscreen display and 
overlay components are covered for 90 days; batteries and incandescent lamps are not covered.  

This warranty extends to products purchased directly from CRESTRON or an authorized CRESTRON 
dealer. Purchasers should inquire of the dealer regarding the nature and extent of the dealer's warranty, if 
any. 

CRESTRON shall not be liable to honor the terms of this warranty if the product has been used in any 
application other than that for which it was intended, or if it has been subjected to misuse, accidental 
damage, modification, or improper installation procedures. Furthermore, this warranty does not cover any 
product that has had the serial number altered, defaced, or removed.  

This warranty shall be the sole and exclusive remedy to the original purchaser. In no event shall 
CRESTRON be liable for incidental or consequential damages of any kind (property or economic damages 
inclusive) arising from the sale or use of this equipment. CRESTRON is not liable for any claim made by a 
third party or made by the purchaser for a third party.  

CRESTRON shall, at its option, repair or replace any product found defective, without charge for parts or 
labor. Repaired or replaced equipment and parts supplied under this warranty shall be covered only by the 
unexpired portion of the warranty. 

Except as expressly set forth in this warranty, CRESTRON makes no other warranties, expressed or 
implied, nor authorizes any other party to offer any warranty, including any implied warranties of 
merchantability or fitness for a particular purpose. Any implied warranties that may be imposed by law are 
limited to the terms of this limited warranty. This warranty statement supercedes all previous warranties. 
Trademark Information 
All brand names, product names, and trademarks are the sole property of their respective owners. Windows is a registered trademark 
of Microsoft Corporation. Windows95/98/Me/XP and WindowsNT/2000 are trademarks of Microsoft Corporation. 
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